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MoDOT CADD Detailing Standards – General Information 

The MoDOT CADD Detailing Standards workflow is created to allow users to create geometry in sheet 
and drawing models that will adhere to our MoDOT standards.  
 

 
 
 
 
MoDOT utilizes the workflow and ribbons for the CADD Standards to enable users to place standardized 
items such as line styles, text, dimension, patterns, cells, and scales. The workflow and ribbons will 
enable the user to place geometry with the correct element attributes (level, color, linestyle, line weight) 
and also invoke the recommended tool with a single mouse click. The workflow has been broken out into 
3 different ribbons – Bridge, Design, and Survey. 
 

 
 

 
 

 
 

MoDOT CADD Detailing Standards 



OpenRoads Designer 

Page 2  
   

Each ribbon is then broken out into other groups to make it easy to find the correct task for the operation 
that you are doing at that time.  Once you select the appropriate task under the ribbon, it will call up the 
appropriate tool to use and change the attributes and/or other settings to the correct MoDOT standards. 
 

 
 
 

What is Drawing Scale (Annotation Scale)? 

The Drawing Scale window is a dockable window that contains controls for viewing and/or modifying 
working units, the annotation scale factor, the Annotation Scale Lock, the active Auxiliary Coordinate 
System (ACS), ACS scale, and ACS scale lock. These settings are particularly relevant to the process of 
creating sheet models for drawing production.  

 

 
Undocked Drawing Scale window 

 

The selection of controls displayed in the Drawing Scale window can be customized by right-clicking in 
the window. The technique is the same as that for showing and hiding tools in toolboxes. 
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For MoDOT standards, the Annotation Scale in the Drawing Scale tool has been customized to include all 
Design files scales and all Bridge file scales.  The Annotation Scale should be set to the scale of the 
Named Boundary placed into the file. 
 
The Annotation Scale will control the size of cells, text, patterns, and dimensions that are placed as well 
as the display of custom linestyles (guardrail line, r/w lines, utility lines, etc.) in the file.  It can also control 
the size of geometry for reference files in the active file if necessary. 
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Activating the CADD Detailing Standards 

The CADD Standards are activated by selecting the appropriate ribbon.  The ribbon will be broken out 
into groups that contain tasks that are associated to that group like CMP-RCP Pipes, Drainage, Drop 
Inlets, etc. 
 

 
 
Once you navigated to the proper group, select the task as needed.  
 
Selecting a task with a single mouse button click will allow that item to be placed on the correct level, 
color and weight.  Using the task also keeps the user from having to attach a cell library or look up what 
level items are to be placed so that everyone at MoDOT is placing the same cells on the same levels.  
This also keeps the user from having to set text heights, widths and spacing.  Dimensions are also 
incorporated in the group to set the correct text attributes, arrowhead sizes and other dimension attributes 
properly. 
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When viewing the tools under a certain group, you will see icons on the left side.  These are indicators 
that basically tell you what tool it will call up when you select that option.  
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Tasks that are associated to the Place Text tool or the Place Dimension tool will have a style applied to 
that task.  Styles are named sets of attributes, such as font, width, height, color, arrowheads, etc. that 
allow you to place text or dimensions within a file in a consistent and automated manner. The text and 
dimensions styles are stored in read-only DGN Libraries to allow management of text attributes and 
dimension attributes throughout the department. 
 

 
 
 

 
 
 
Once a style has been used, it will embed itself in the file.  This allows the file to be easily transferred to 
another department or company that may not have our MoDOT CADD setup, like a utility company. 
 
Since styles will embed themselves in the file, the style can be modified or changed to whatever settings 
needed for that text or dimension to be placed.  These settings will stay applied to the text style or 
dimension unless you select a certain text or dimension task.  Then it will pull the style from the DGN 
Library for that text or dimension you need to place in the file. 
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MoDOT has customized a couple items inside of OpenRoads Designer.  This has been done to help 
users locate certain tools that may be hard to find in the default ribbons that are provided in OpenRoads 
Designer.  It has been done also in ensure our CADD detailing standards are located in a location for our 
users to easily find them. 

CADD Detailing Standards 

The MoDOT CADD Detailing Standards workflow is created to give users a central location to have all 
detailing standards for plan production.  It is broken out into 3 separate ribbons called Bridge, Design, and 
Survey.   

 
For more details on this subject, they are provided in the section called CADD Detailing Standards and 
Annotation Scale. 
 

 

 
 
 

 

 

 

 

 

OpenRoads Designer Customized Items 
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MoDOT Misc. Pulldown 

The MoDOT Misc. pulldown is added to the interface for users to easily find tools that may be hard to 
locate in the default ribbons in OpenRoads Designer.  
 

 
 
 
 
 
At the bottom of the list will be an option called Misc Apps.  This will contain tools to activate applications 
that may be installed on the computer that work in conjunction with OpenRoads Designer.  
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Civil Accudraw – General Information 

Civil AccuDraw performs many of the same functions as MicroStation AccuDraw but has greatly 
expanded capabilities for the civil designer. It allows the user to define a point location at any stage of any 
placement tool and accepts input that results in more sophisticated point locations. 
There are many benefits in using Civil AccuDraw.  It extends the drafting power of MicroStation by 
providing Civil point location methodologies in all the MicroStation and Civil commands.  It will also 
eliminate the need to create temporary construction geometries just to perform more complex point 
locations. In general, Civil AccuDraw works in a similar way to MicroStation AccuDraw. However, there 
are some differences and some limitations that will be addressed in future versions. 
 
Differences 

• Smart lock (<Enter>) is not supported in Civil AccuDraw. Similar functionality is possible by key-in 
and locking a value corresponding to the compass point. 

• Spacebar does not switch Civil AccuDraw modes. It opens the mnemonic pop-up which provides 
similar and additional functionality. 

• O shortcut is subtly different. MicroStation AccuDraw reads the cursor position at the instant that 
O is pressed. Civil AccuDraw waits for a DP. In addition, in Civil AccuDraw, the O shortcut also 
serves to pick the base element for station or offset ordinates. Once chosen this element is 
remembered for the duration of the session or until changed by user. 

• In Civil AccuDraw, the delta Z origin can be set independent of the XY origin. 
• When in a 3D model, the Civil AccuDraw compass always considers X, Y and Z as separate and 

distinct. For example, using Civil AccuDraw in a side view, the Y and Z ordinates will dynamically 
track values. On the other hand, MicroStation AccuDraw would still call the ordinates X and Y 
even though in a side view. Keeping the ordinates distinct and separate lays the groundwork for 
future enhancements where other Z ordinates such as slope will be introduced. 
 

Limitations 

• Angle input: 
The use of d, m and s for degree, minute and seconds delimiters is not supported. 
Input angle in the form DD^MM.mm is improperly interpreted as DD^00’MM.mm”. 

• Stationing:Station-offset using a closed B-spline may be incorrect. Civil AccuDraw cannot 
consume the stationing on alignments stored in GPK, ALG nor FIL files. The graphical elements 
representing these alignments can be selected but Civil AccuDraw will interpret the starting 
station as zero. 

• When using Civil AccuDraw and viewing the shortcuts list, there may be shortcuts listed which 
have no function in Civil AccuDraw. Civil AccuDraw shares the shortcuts.txt file with MicroStation 
AccuDraw and some of the shortcuts are not relevant or have not been implemented in Civil 
AccuDraw. 

• In the shortcuts list, if ordinates are station-offset and you choose Set Origin, clicking Run has no 
effect. 

• Alternate Coordinate Systems (ACS) are not recognized by Civil AccuDraw. 
• Civil AccuDraw will override File Settings > Grid Lock. This is by design. Toggle Civil AccuDraw 

off if the grid lock function is required. Similar functionality can be achieved within Civil AccuDraw 
by setting the round off values in Civil AccuDraw settings. 
 

Civil Accudraw 
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Working with Civil Accudraw 

Activating Civil Accudraw 

By MoDOT default, the Civil Accudraw toolbar is active and located at the bottom on the window. 

 

The toolbar can also be activated by going to Tools > Civil Accudraw > Activate Toolbar. 

To activate Civil Accudraw, toggle on the Civil Accudraw icon.  

 

Coordinate Display 

 
The coordinates of the current cursor position are displayed by default in a floating dialog. You can switch 
between the floating or fixed dialogs using the up and down arrow keys. The contents of the dialog will 
depend upon the current ordinate system selected. For example, the default system of Distance and 
Direction will display distance and angle. If the model is 3D, Z will also be displayed. 
 
Only one dialog is displayed at a time. 
 
Floating Dialog 
The floating dialog is displayed close to the current position of the cursor. As the cursor moves, the dialog 
moves and is automatically updated with the new coordinate information. Press the down arrow to switch 
to the fixed dialog. 
 

 
 
Fixed Dialog 
The fixed dialog is a normal dialog and can be repositioned or docked. As the cursor moves, the dialog is 
automatically updated with the new coordinate information. Press the up arrow to return to the floating 
dialog. 
Fixed Dialog versus Floating Dialog 
The default operation of Civil AccuDraw is with a floating dialog at the cursor for feedback and input of 
ordinate values as shown below. 
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Compass 

The center of the compass indicates AccuDraw's origin point. The Civil AccuDraw compass is only 
displayed when Civil AccuDraw is active. It can also be disabled in Settings > Operation tab. 
 
The compass is always circular and is marked by a number of tics. The default is 4 compass points, this 
can be changed in Settings > Operation tab. 
 

 
 
Compass Shortcuts 
The compass can be rotated with the V, B, T, RQ, RE shortcuts. The north arrow on the compass will 
always point to north as defined in Settings > Design File > Angle Readout. 
 
If the Civil AccuDraw settings have context sensitive turned on, then the compass auto-rotates in a similar 
fashion to MicroStation AccuDraw:  

 

Floating 
 

North Arrow 

Compass 
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Note that rather than Direction being shown, the label and value are now an angle. This is because the 
context is based on the direction of the preceding line segment rather than an absolute direction. 
 
Use the T (Top) shortcut or the corresponding drop-down to return to a pure direction. 
 
 

 
 
The angle/direction settings used in Civil AccuDraw are taken from the file settings. See Settings > 
Design File Settings > Angle Readout category topic of MicroStation help. 
 

 

 

Tips when using with MicroStation or Civil Geometry tools 

• Selecting the Tab key while in an entry field will change focus. 
• Selecting Enter will set the value in the field and lock it 
• Selecting the End key will unlock the field 
• Selecting the Left or Right Arrow key will move through the favorite options. 
• Selecting the Down key will bring up the associated command entry dialog in addition to the 

heads-up display. 
• Selecting the Up key will remove the command entry dialog and just display the heads-up 

display. 
• Selecting the O key will allow to select a reference element or point for using certain civil 

accudraw commands like Station-Offset, Offset-Offset, Distance-Distance, etc. 
• To input a Bearing in the direction field for civil accudraw, the following are valid forms: 

• 12:34’56 
• 12:34’56” 
• 12:34:56 
• 12^34’56” 
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Civil Accudraw toolbar 

This toolbox consists of icons to toggle Civil AccuDraw and access the Civil AccuDraw commands. 

 

Toggle Civil Accudraw 
To activate or deactivate Civil Accudraw 
 

 

Civil Accudraw Settings 
To access the Civil Accudraw settings dialog.  See Civil 
Accudraw Settings section for more information. 
A quick drop-down menu will be display when holding 
down the left mouse button over the icon.  This provides 
access to many Civil Accudraw shortcuts. 

 

 

 

 

 
X-Y 
To set the order of entry based on absolute X-axis and Y-axis, with both sharing the same point of origin. 

 
 

 

 
 
DX - DY 
To set the order of ordinate entry to the difference in X coordinate then the difference in the Y coordinate, 
with both sharing the same common point of origin. 
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Distance & Direction 
To set the order of ordinate entry to distance then direction, with both sharing the same point of origin. 
 
 

 
 
Station & Offset 
To set the order of ordinate entry to station identification then offset value, with both sharing the same 
point of origin. 
 
 

 
 
Distance & Distance 
To set the order of entry to distance for the first ordinate then distance for the second ordinate, without a 
common point of origin. 
 
 

 
 
Direction & Direction 
To set the order of entry to direction for the first ordinate then direction for the second ordinate, without a 
common point of origin. 
 
 

 
 
Offset & Offset 
To set the order of entry to offset for the first ordinate then offset for the second ordinate, without a 
common point of origin. 
 



OpenRoads Designer 

Page 15  
   

Civil Accudraw Coordinate Systems 

Horizontal Ordinates 

 
With MicroStation AccuDraw, the user is limited to X-Y (rectangular) or Distance-Direction (polar) 
coordinate systems. With Civil AccuDraw, the user may define an ordinate system from virtually any 
combination of the following ordinates. 
 
Note: Some combinations are not allowed simply because they do not make sense. For example: Dx - Dx 
 
X: Absolute value of X coordinate 
Y: Absolute value of Y coordinate  
Dx: Delta X (change in X) from compass origin 
Dy: Delta Y (change in Y) from compass origin 
Distance: Horizontal distance from the compass origin 
Direction: Direction (as per Settings > Design Settings > Angle Readout) from the compass origin. 
Station: The distance measured along an element. Any graphic linear element may be used. Use the 
Origin shortcut to choose the element. 
Offset: The distance measured perpendicular from an element. Any graphic linear element may be used. 
Use the Origin shortcut to choose the element. 
 
 

Angle Syntax 

The input for angle and direction fields follows the MicroStation Settings > Angle Readout settings. 
 
Valid forms 
Valid forms for the various settings are as follows: 
 
DD.DDDD, Radians or Grads - Use the customary decimal input. 
DD MM SS or DD MM - The following delimiters are supported between degrees, minutes and seconds: 

• Colon - For example DD:MM:SS 
• ^ (caret) to designate degrees, minute (’r;) and second (”r;) - For example DD^MM’SS” 

 
The following are not supported in the current version: 

• A space between degrees, minutes and seconds because space launches the Civil AccuDraw 
popup menu 

• Use of d, m and s to designate degrees, minutes and seconds. 
 
Examples 
The following are all valid forms for 12 degrees, 34 minutes, 56 seconds: 

• 12:34’56 
• 12:34’56” 
• 12:34:56 
• 12^34’56” 
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Civil Accudraw Settings 

 
There are various Civil AccuDraw settings to enable you to customize the functionality and appearance of 
the Civil AccuDraw tools. 
 
You can open Settings by selecting the icon from the Civil AccuDraw toolbox. 
 

 

 

 

Operation tab 

 

 

Auto Load 
On:  Civil AccuDraw starts when MicroStation is loaded. 
 
Floating Origin  
On:  the origin moves to the last point placed. 
Off:  the origin remains fixed. 
 
Context Sensitivity  
On:  the compass rotates in response to the context of various tools. 
Off:  the origin remains fixed 
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Smart Key-Ins 
On:  Civil AccuDraw interprets a number as positive or negative, depending on the direction of the pointer 
from the compass. 
XY ordinates only:  Smart Key-ins cause Civil AccuDraw to move the focus to either the x or the y field 
depending on the pointer position. 
 
Preserve Method Locks 
On:  the locked values remain locked after switching the ordinate methods. For example, using station-
offset ordinates and a lock station of 1+00, switch to distance-direction ordinates. Station 1+00 will remain 
locked while inputting distance-direction. The resulting effect will be a distance-direction-station lock. 
 
 
Sticky Z Lock 
On:  inputs to Z ordinates remain locked (sticky) until they are changed. This is useful in a 3D file to 
control the Z ordinate. For example, input 100.00 for the Z ordinate and the value remains constant until 
changed. 
Off:  the Z ordinate follows the cursor dynamics. 
This also controls whether the origin for delta Z measurements follows the XY origin or is independent of 
XY. 
 
On:  the origin for delta Z is completely independent of the XY origin. For example, the user can set the 
origin for dXdY measurements from point A and set dZ to be measured from a second point B. The Z 
origin does not change until reset by the user. The effect will be apparent when drawing a linestring. 
When drawing a linestring, the dynamic orientation of the compass will adjust to align with the most 
recent line segment. The Z origin will remain fixed wherever the user placed it at in the beginning. 
 
Note:  When Accudraw ordinates are set to X,Y the sticky Z toggle does not apply. This is because, by 
definition, XY mode is always assumed to be absolute. 
 
Always Show Compass 
On:  the compass is always visible. 
Off:  the compass is only visible when the appropriate input is required. 
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Display tab 

 
 
 
 
Compass 
X Axis: Sets the color of the positive X axis tick mark on the compass. 
Y Axis: Sets the color of the positive Y axis tick mark on the compass. 
Fill:  Sets the fill color of the compass circle. 
Points:  Sets the number of compass points indicated by tic marks.  In addition to tic marks, the axis 
locks are also honored on the tic marks. 
 
Constraint Dynamics 
Show Constraints:  Shows dynamic feedback for the ordinate systems in use.  For example, with 
Distance-Direction ordinates a circle indicating distance and a line indicating direction is displayed. 
Standard:  The color of the constraint dynamics. 
Hilite:  The color of constraint dynamics when they are constrained by an axis lock. 
Locked:  The color of the dynamics when they are locked by a user key-in. 
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Coordinates tab 

 

 

 

Unit Round-off 
Defines a stepping value so that ordinate values are rounded to an even increment. Separate round off 
values are available for distance, angle, station and offset. The distance value also affects coordinates. 
Check the tick box beside each setting to enable it. 
 
Indexing  
Axis:  If ON and if you get close to a compass point then the Civil AccuDraw dynamics lock onto the 
compass point direction. 
Distance:  If ON and if you get close to a recall distance then the dynamics lock to the recalled value. 
Tolerance:  For indexing, how close the cursor must be to the item in question when the indexing takes 
effect 
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Favorites tab 

 

 

The Favorites tab allows for the configuration of the most commonly used ordinate systems.  It is one of 
the primary differentiators between Civil AccuDraw from MicroStation AccuDraw.    The favorite selected 
determines what input fields are available during the placement of an element. 
 
Most logical combinations of ordinates are allowed. See the section Civil Accudraw Coordinate Systems > 
Horizontal Ordinates for an explanation of the ordinate types. 
 
Name:  The user defined name of the designated coordinate system 
 
Ordinate 1:  The type of ordinate set for the first ordinate. (Available ordinates are X, Y, Distance, 
Direction, Station, Offset, Dx, Dy) 
 
Ordinate 2:  The type of ordinate assigned to ordinate 2. 
 
Common Origin:  If YES, the two ordinates have the same origin.   
If NO, the two ordinates are measured from different origins.  For example, for a Station-Offset ordinate 
system where Common Origin is set to YES, the station and offset are both measured from the same 
alignment.   
If NO, then the station is measured from one alignment and the offset is measured from a different 
alignment. 
 
Icon:  The icon displayed on the Civil AccuDraw toolbox. Usually a suitable icon is selected automatically, 
but you can define any icon. 
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Named Boundary – General Information 

The Named Boundary tool is used for the composition of drawing models and sheet models. From the 
default model, this tool will basically create a drawing model and a sheet model.  The Drawing model is 
used to detail elements that don’t need to be in the default model.  Geometry like text, notes, dimensions, 
etc. are examples of what are commonly placed in the drawing model.  The Sheet model will contain what 
has been placed from the default model and drawing model.  Along with that, the border file will also be 
placed the sheet model. 
   
Nothing should be done in the sheet model, except for editing the title block information. Any 
other modifications done the sheet model will not be supported by MoDOT CADD Support. 

While there are many different variations that you can do when using the Named Boundary tool to create 
certain plan production drawing and sheet models that will contain the border, the steps below will give 
you a general workflow on how to use the Named Boundary tool for a detailed file like typical sections, 
quantities, special sheets, bridge drawings, etc. 

For information on using the Named Boundary tool to create plan, profile, plan-profile, plan-plan and 
cross sections, please refer to the MoDOT online training documentation under OpenRoads Designer – 
Road 1.  There is a chapter called Plans Production that will go into detail on those type of sheets. 

For more detailed information on the Named Boundary tool, please refer to the online Bentley help in 
MicroStation section. 

 

 

Named Boundary – General Workflow 

1. Select a workflow that contains the Named Boundary tool. 

 

 

 

 

Named Boundary 



OpenRoads Designer 

Page 22  
   

2. Select the Placed Named Boundary option under the Named Boundary tool. 

 

 

 

3. In the Place Named Boundary dialog, change the options as desired to produce the clipping 
shape for the plan sheet. 

• For this example, fill out as shown below. 

 

 

a) Clipping shape options - set to From Drawing Boundary 

b) Drawing Boundary - select Design - D Size Sheet 

c) Name – user defined.  This will be the name of the boundary under the Name 
Boundaries after the boundary has been created 

d) Detail Scale – as desired to get geometry inside the boundary 

e) Create Drawing - toggle off  

 
 
 

a 

 

 

b 

 

 

c 

 

 

d 

 

 e 

 

 



OpenRoads Designer 

Page 23  
   

4. Once the Named Boundary dialog has been completely filled out, place the boundary in the 
desired location in your default model. The boundary can be moved after it has been placed if 
needed. 

 

5. Now that the boundary has been created, you can now start the process to create the plan sheet. 

Select the Manage Named Boundary tool. 

  

 

6. Toggle on the Show the Create Drawing Dialog option. 

 

 

 

7. Click on the triangle (down arrow) to expand out the Other Groups.  Right click over the desired 
group or boundary and select the Create drawing option.   
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8. In the Create Drawing dialog, most options will be set to the proper settings and you will not 
need to modify.  But there’s a few that you will need to review and possibly change. 

• For this example, fill out the dialog exactly like the dialog below. 
 
 

 
 

 
a) Name – will be the name of the drawing and sheet model.  Keep this in mind if you use 

the Sheet Index so you can arrange them properly 

b) Annotation Scale (drawing model) – set to the same scale of the placed named 
boundary 

c) Detail Scale – set to the same scale of the placed named boundary 

 

Once everything is set, click OK to create the drawing and sheet models. 

a 

 

 

b 

 

 

c 

 

 



OpenRoads Designer 

Page 25  
   

9. Open the sheet file and review. 

In the Models tool, you will see that it created a drawing model and a sheet model. 

 

The Drawing model is designed to add geometry like text, notes, dimensions, extra reference 
files, etc. to the file. The drawing model is still a 1:1 scale, so everything is the same scale as 
from the file that you cut the sheets from.  

 

The Sheet model takes what is in the default and drawing models and scales it down to fit the 
border that is in the Sheet Model.  Adding geometry (except for the text that is needed for the 
border information) to the sheet model is not recommended or supported by CADD Support. 
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Sheet Index – General Information 

A sheet index is a centralized and structured collection of sheets in your project. Sheet index can be 
useful in creating a sheet set that contains all the sheet models. You may link any sheet model from any 
design file of your project into a sheet index. You can then collectively manage properties of all the sheet 
models within the sheet index. Sheets can be organized hierarchically in folders.  Sheet indexes can also 
be opened using the Print Organizer for printing.  
 
While using the sheet index, the sheet numbering rules enable you to define rules to generate sheet 
numbers for all sheets in the sheet index. Custom properties can be attached to sheets and placed as 
text fields in the sheet. Custom properties can also be attached to the folders and the sheet index.  
 
Note: Sheet numbering and custom properties will not be used at this time at MoDOT.  The Create 
Renditions application currently will not read the text for the sheet numbers and custom properties fields 
properly from the ORD file. 

Sheet Index – Adding Sheet Models to Index 

1. In the Sheet Index tab within Explorer, select the sheet index or the folder to which you want to 
add the sheet(s) into. 

 

2. Click Open Sheet Index for Edit to open the sheet index in editing mode. 

 

Sheet Index 
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3. Click Add Sheet. 

 

4. In the Add Sheet dialog, select the files that contain the sheet models and click OK. 

5. The next Add Sheet dialog will list the sheet models available for being added to the sheet index. 

Select the sheet(s) that you want to add the sheet index. 

 

6. Click OK to accept. 
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Sheet Index – Deleting Sheet Models from Index 

1. In the Sheet Index tab within Explorer, select the sheet index (Roadway). 

 

2. Click Open Sheet Index for Edit to open the sheet index in editing mode. 

 

3. Select the sheet(s) that you need to remove. 

Then click Delete to remove sheets from the index. 
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Sheet Index – Rearranging Sheet Models  

1. In the Sheet Index tab within Explorer, select the sheet index (Roadway). 

 

2. Select the sheet model that needs to be moved.   

3. While holding the left mouse button down, simply drag the sheet model the desired location 
between other sheet models.  The blue line will indicate the location of where it will be place at.  

Release the mouse button to place the sheet model in the new location. 
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Sheet Index – Opening a Sheet Model through the Index 

1. In the Sheet Index tab within Explorer, select the sheet index (Roadway). 

 

2. Select the sheet model.  

 

3. Then simply double left click on the sheet model.  This will open the file that contains that sheet 
model. 

 

 
 
 
 
 



OpenRoads Designer 

Page 32  
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Printing – General Information 

Printing files in OpenRoads Designer will consist of two options.  One option is to use the standard print 
tool inside of ORD.  This has been configured to print .dgn files to .pdf files to the desired location inside 
or outside of ProjectWise.  The other option will be to use the Create Renditions option inside of 
ProjectWise to create the .pdf file.  Then the .pdf files can be printed to the user defined printer.  
 

Printing – Sheet Model 

4. With the sheet model active, select the Print tool in the Quick Access toolbar. 

  

 
 OR go to the File ribbon and select Print under the Print option. 
 

 
 

 

Printing 
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5. Change the sheet size to the desired size (B-Size or D-Size). If you change the sheet size, you 
will need to select the Maximize option to maximize the sheet model. 

 

 

6. Review the Print Attributes and turn on/off the attributes as desired for your sheet print.  

Click OK when the attributes are set. 
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7. Select Print to File… to create the print. 

 

 

 

8. In the Save Print As dialog, determine the location of where you want to save the .pdf file to.   

You can also change the Name and File Name if desired.   

Once you have everything set, select Save to create the sheet model .pdf file. 

 

 

9. Now the .pdf file will be created in the folder you assigned it to be created into.  Then you can 
open the .pdf file and print it out to the desired MoDOT printer. 
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Printing – Fence Area 

1. Open the model (default, drawing, or sheet) you need to create printing fence into.   

Select the Place Fence under the File ribbon. 

Place the fence around the area that you need to print out. 

 

 

 

2. Select the Print tool in the Quick Access toolbar. 

  

 
 OR go to the File ribbon and select Print under the Print option. 
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3. Change the Printer and Paper Size option to MoDOT PDF – Fence.  This will allow you to use 
the fence that you defined instead of the sheet model properties. 

  

 

4. Change the sheet size to the desired size. If you change the sheet size, you will need to select 
the Maximize option to maximize the fenced area. 

Long plot sizes are only to be used for fenced area for a long project strip map.  This will be cover 
in a different section in printing. 
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5. Review the Print Attributes and turn on/off the attributes as desired for your sheet print.  

Click OK when the attributes are set. 

 

 

 

6. Select Print to File… to create the print. 
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7. In the Save Print As dialog, determine the location of where you want to save the .pdf file to.   

You can also change the Name and File Name if desired.   

Once you have everything set, select Save to create the sheet model .pdf file. 

 

 

8. Now the .pdf file will be created in the folder you assigned it to be created into.  Then you can 
open the .pdf file and print it out to the desired MoDOT printer. 
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Printing – Using Fence for Preliminary Strip Map 

1. You will need to place the correct preliminary strip map cell for the limits of the desired printing 
area you wish to print out. 

Go to the MoDOT CADD Detailing Standards workflow. 

 

 

2. Go to the Design ribbon and select the Preliminary Strip Maps tools.   

In here, select the proper annotation scale and length for the limits of the project area. 
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3. Place the cell in the desired location.  You can now use this cell as the boundary limits for when 
you create the fence to define the printing area.  Using the cell will ensure the scale is correct 
when you print it out. 

 

 

4. In the default model that the preliminary strip map cell is placed in, you will need to create the 
printing fence.   

Select the Place Fence under the File ribbon. 

Use the cell shape and select the upper left and lower right corners of the shape to place the 
fence around the area. 
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5. Select the Print tool in the Quick Access toolbar. 

  

 

 
 OR go to the File ribbon and select Print under the Print option. 
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6. Change the Printer and Paper Size option to MoDOT PDF – Fence.  This will now use the fence 
that you defined instead of the sheet model properties. 

  

 

7. Change the sheet size to the desired “Long Plot” size. This should match the size of the cell that 
you previously place in the .dgn file.  

If you change the sheet size, you will need to select the Maximize option to maximize the fenced 
area. 
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8. Review the Print Attributes and turn on/off the attributes as desired for your sheet print.  

Click OK when the attributes are set. 

 

 

 

9. Select Print to File… to create the print. 
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10. In the Save Print As dialog, determine the location of where you want to save the .pdf file to.   

You can also change the Name and File Name if desired.   

Once you have everything set, select Save to create the sheet model .pdf file. 

 

 

11. Now the .pdf file will be created in the folder you assigned it to be created into.  Then you can 
open the .pdf file and print it out to the desired MoDOT printer. 
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Printing – Multiple Sheets (Using Sheet Index) 

In order to print multiple .dgn files inside of OpenRoads Designer, you will need to use the 
application called Print Organizer.  The Print Organizer basically allows you to add and subtract 
sheet models inside of it and then you can print out all those files at one time.  It also allows you 
to save the set of files for future printing if desired. 

If the Sheet Index is set up, you can use that list of sheet models for the Print Organizer 
application.  You can also access the Print Organizer through the backstage, but you would need 
to manually add the sheet models you want to print out. 

1. Go to the Explorer and select the Sheet Index option. 

Select Design in the Sheet Index. 

 

 

2. Click on the Open Print Organizer tool inside of the Sheet Index. 
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3. In the Select Print Style dialog, select the PDF – Sheet style and click OK.   

The PDF – Fence style will not work in this situation for printing multiple files. 

 

 

4. This will open the Design.pset (print set) in the Print Organizer.  In here, you can select which 
files you want to print out.  Whatever is listed on the right side of the dialog box will be what you 
can select to print. 

 

 

You can also add files or/and folder to this print set if needed.  
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Once you have the list of sheet models completed, select the Print option. 

If you are wanting to just print out certain models in the list and not the whole list, select those files 
first and then select the Print option. 

 

5. In the Print dialog, you will need to determine the following options: 

 

• Print Range - All the sheet models or Selection of files that you previously selected 

• Submit As – Separate Print Jobs which will print the files into separate .pdf files or     
Single Print Job which will combine all the selected files and put them into one single .pdf 
file. 
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• Destination – location for the .pdf file(s) being created.  The Use source directory for print 
destination toggle allows you to create the .pdf files in the same location as the source sheet 
model. 

• Output File Names – when using the Separate Print Jobs option, you will have the option to 
change the way it outputs the name of the files you are print out. 

Once you set all the options to the way you want them, click OK to create the .pdf files. 

6. The .pdf file(s) will be created in the folder you assigned it to be created into.  Then you can open 
the .pdf file(s) and print it out to the desired MoDOT printer. 

Printing – Multiple Sheets (Through the Backstage) 

Accessing the Print Organizer through the backstage will work the same as if you accessed it 
through the Sheet Index.  The only difference is you will need to manually add which files (sheet 
models) you want to print. All the other steps work the same for the Print Organizer application. 

1. Go to the File tab.  

In the backstage, select the Print Organizer application under the Print option. 

 

 

 

 

 

2. Now you will need to manually add the sheet models to the print set. 

 

The other steps for printing multiple sheets are exactly the same as the Printing – Multiple 
Sheets (Using Sheet Index) section. 
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Printing – Creating & Saving Print Set 

When using the Print Organizer, you can save out the print set (.pset) file.  Saving a print set will 
allow you to print out that same set of files again without manually adding those files over and 
over each time.  This could be useful for printing out preliminary plans, set of traffic sheets, set of 
typical section sheets, etc. and then you could access that print set on a later date to print them 
out. 

1. Open the Print Organizer through the Sheet Index or from the Backstage window. 

 

2. In the Select Print Style dialog, select the PDF – Sheet style and click OK.   

The PDF – Fence style will not work in this situation for printing multiple files. 

 

 

3. This will open the .pset (print set) in the Print Organizer.  In here, you can select which files you 
want to print out.  Whatever is listed on the right side of the dialog box will be what you can select 
to print. 
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You can add files or/and folder for the print set if desired.  

 

4. Once you have the list of sheet models completed, select File > Save As. 

 

5. In the Save Print Set File dialog, change the Name and File Name for the name of the print set 
file.  Also change the Folder location to the desired location. Select Save to save the print set. 
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6. Now anytime you use the Print Organizer, you can come back and open that .pset print set file to 
print out those sheet models in the list. 

Note: If you print out those sheets and changed some settings inside the Print dialog box, those 
settings will also be saved with the print set if the print set is saved after doing the print. 
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F1  -  Activates the OpenRoads Designer Help information 

F2  -  Opens the CADD Services SharePoint page 

F3  -  Opens the CADD Services YouTube Channel for online videos 

F4  -  Defaults to the PowerSelector tool and deselects everything in the file 

F5  -  Activates the Redraw tool under the Survey task 

F6  -  Used to open View 2 in an Isometric rotation along with the Display Style representation set to Illustration.  
Used for 3d files only. 

F7  -  Toggles off/on Construction elements  

F8  -  Toggles background color (black to white, white to black) 

F9  -  Activates View Settings pop-up  

F10  -  Activates the Excel to OpenRoads Designer tool to import data from the Quantab excel sheet. 

F11  -  Activates the Analyze Point tool under the Terrain Model task.  Also toggles on Civil Accudraw and sets 
the Civil Accudraw option to Station-Offset 

F12  -  Opens the corridor template library 

 

Ctrl+F1  -  Creates a Display Set of the elements that you have selected within the file 

Ctrl+F2  -  Clears out an active Display Set 

Ctrl+F6  -  Activates key tips for the ribbons 

Ctrl+F7  -  Activates tab key tips for the ribbons 

 

Shift+F1 -  Activates a tool to exaggerate a terrain model.  This will only work in a 3d file and it creates a 
temporary model for viewing purposes only. 

Shift+F7 – Toggles off/on Line Weights 

Shift+F9 – Removes any unused fonts and compresses the file 

 

 

 

MoDOT Default Function Key Assignments 
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Left Button  -  Data (accepting a command, operation, or tool) 

Middle Button -  Pan 

Right Button  -  Reset (exiting a command, operation or tool) 

Left & Right Button  -  Tentative Snap 

Alt + Left Button  -  Match attributes from cursor 

Alt + Middle Button  -  Rotate view from cursor 

Alt + Left & Right Button  -  3d data (3D file only)  

Ctrl + Middle Button  -  Navigate swivel (3D file only) 

Ctrl + Left & Right Button  -  Accudraw set origin (Accudraw must be active)  

Shift + Middle Button  -  Rotate view dynamically 

Shift + Right Button  -  Popup ribbon for View tools 

Shift + Left & Right Button  -  Popup ribbon for Snap options 
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